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1. Activation  

Activation using Windows  

After opening Nature projects for the first time, you will be 

prompted to activate the program. Complete this by following the 

steps described below: 

Install Nature projects as described in the installation guide. 

Enter a serial number. If you have purchased the box version, this 

can be found in the accompanying information booklet. For custom-

ers who have purchased downloadable versions of the software, the 

serial number was sent to your registered email address immediate-

ly after the purchase. 

 

 

Click on the “Activate now”-button. You have now successfully acti-

vated the software! 

 

Activation using Mac 

After opening Nature projects for the first time, you will be 

prompted to activate the program. Complete this by following the 

steps described below: 
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Install Nature projects as described in the installation guide.  

Enter a serial number. If you have purchased the box version, this 

can be found in the accompanying information booklet. For custom-

ers who have purchased downloadable versions of the software, the 

serial number was sent to your registered email address immediate-

ly after the purchase.   

 

 

Click on the “Activate” button. You have now successfully activated 

the software!  

NOTE: You can use your serial number to install NATURE pro-

jects on up to two different computers. 

No second serial number is needed. Simply enter your first serial 

number during installation on your second computer. Following 

entry, click on “Activate”. 
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2. User Interface Configuration   

Adjustable Font Size for Menus and Headings  

Provided in the program’s main menu under View -> Font Size, this 

option lets you customize the font size of menu texts as well as in-

program headings.  

 

Font size settings can be adjusted directly at program runtime.  

Users working on 4K monitors have the possibility to improve menu 

legibility by increasing the font size.  
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3. Finished Image Edits in No Time 

Five clicks in NATURE projects and you’re done: 

1. Upload Images  

 

 Simply drag and drop your images onto the program interface. 

 

2. Post-Processing   Select Preset   
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3. Configure Optimization Assistant  

 

 

4. Create a random weather condition  

 

 

 

 

 

5. Crop the image, save and you’re done!  
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Just like that and you’re finished editing in no time – or go the crea-

tive route with individual image adjustments, the RAW Module or 

selective painting:  

NATURE projects offers the necessary tools for both.  

Located at the top of your screen is the main menu along with the 

toolbar. The toolbar contains the following functions: 

 

o Image Data Browser     

 

o History Viewer      

 

o Load Image      

 

o Open Project      

 

 

Images can be “dropped” onto the screen using a quick drag-and-

drop. These images are then automatically uploaded. 
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4. Image Weather Assistant Module 

 Use the Image Weather Assistant 

to combine various weather 

conditions and give your image an 

entirely new look.  

You can select from a range of 

various weather conditions such 

as “Spring Rain”, “Clear Night”, 

“Snowstorm”, etc..  

 

Here’s an example: The original image is a normal landscape photo-

graph. 

 

The changes made in the Image Weather Assistant create a variety of 

new moods: 
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Night:  

 

 

Thunderstorm: 

 

 

 



NATURE projects – User manual 

 

12 

Morning Sun: 

 

With the button located underneath, reverse any changes made in 

the Image Weather Assistant.  

 

 

Go in and adjust the weather by 

hand using any of the seven slide 

controls. Select from Fall or 

Spring, dull or sunny days or be-

tween day and night.  
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The seven slide controls at the bottom offer additional setting con-

trol for: Horizon, Sun, Snow, Rain, Rainbow, Lightning, Moon and 

Stars.  

Note: Depending on the weather condition selected, not all symbols 

may be activated at the same time. Adjust the top-most slide control 

to activate the symbols for additional settings. 

 

 

 1. Horizon: Determine the height of the horizon by activat-

ing the Position Pipette  and clicking on the preferred 

point within your image.  

 

 

 2. Sun: The Position Pipette  enables you to position the 

sun within your photograph. Activate the lens reflection or 

sunbeam effects and adjust their size, intensity and length.  
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Image before and after applying the adjustments to the sun 

settings 
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 3. Snow: Decide how large to make your snowflakes. 

 

 

 

 

 

 

 

 

 

 

 

 

 



NATURE projects – User manual 

 

16 

 4. Rain: Here you can determine the rain’s direction, length 

and level of transparency.  

 

 

 

 

 

 

 

 

 



NATURE projects – User manual 

 

17 

 5. Rainbow: Position 

the rainbow in your im-

age with the help of the 

Pipette tool  . You 

can also make adjust-

ments to the rainbow’s 

radius and width within 

the settings. 
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 6. Lightning: Determine lightning opacity, intensity, distribu-

tion and dynamics. Lightning Distribution specifies how 

much electrical energy dis-

integrates into smaller 

branches and how much 

remains concentrated in 

the main branch. Lightning 

Dynamics controls the lin-

earity of the lightning 

strike. Adjust the position 

of the small boxes shown 

in the thumbnail to change 

the length or positioning 

of the lightning bolt.  
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 7. Moon and Stars: Acti-

vate or deactivate 

(show/hide) the moon us-

ing the settings at the top. 

Position the moon in your 

image using the pipette 

 . Specify the size, lunar 

phase and aura of your 

moon using the slide con-

trols below. The lunar 

phases range from a wax-

ing to a waning moon. In 

addition, the size and 

density (quantity) of stars 

can be specified within 

the settings.  
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The large button situated between the plus and minus symbols gen-

erates a random weather condition. If you’re having trouble deciding 

on a weather condition or just want to see a recommendation, this 

function will put you on the track. Clicking on the plus or minus sym-

bols will either intensify or reduce the effect the of the weather con-

dition.  

 

The “Copy Image Result to Original” function set the current image as 

the new original image just as if you had been using this image from 

the start. Use this function to save on computing time while working 

on projects with lots of added effects. This enables you to apply 

special effects such as Lightning, Rainbow and Moon to your images 

multiple times.  
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5. Uploading Image Material 

Upload your image by simply dragging and dropping your image into 

the program window. You can upload images from the File Menu.  

 

 

 

 Image Browser 

 Use the image browser for a better overview of your images before 

uploading.  

Click on the Image Browser symbol in the menu bar. This will open 

the preview window. Select your image folder as the “Source Folder”. 

NATURE projects will then display an image preview. Glide your 

mouse over the image preview to enlarge it.  

Useful here is the File Type Filter. JPG series are often stored togeth-

er with RAW images in the same folder: Enter RAW in the File Type 

field and only RAW images are displayed without duplicates.  

The search for images is completed at 100%.  
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Now you can upload your selected image. Right-click your preferred 

image and select “Open as a Project”. Double-clicking the image will 

open the image in Preview. 
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NATURE projects uploads your image just as with the simply drag-

and-drop. Now we can begin with Post-Processing. 
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6. Menu Bar 

6.1 File 

 

File → Homepage  

When you are finished 

editing an image or would 

like to close your current 

image, clicking on Homep-

age (or Ctrl + N) will close 

the current image.  

 

File → Load Image  

To open an image, click on 

Upload Exposure Bracket 

(or Ctrl + Shift + O) to 

search for the image you 

would like to edit. 

 

File → Image Browser  

Select your bracket folder from within the “Source Folder”. NATURE projects 

immediately starts its calculation and provides an image preview. It is from 

here that you can then upload your preferred image. 

 

File → History Viewer  

Clicking here will provide you with an overview of your separate images and 

projects allowing you to choose between them. Double-clicking on images or 

projects will open these.  
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File → Save Final Image  

If you are satisfied with your editing results and wish like to save your image, 

click on Save Final Image (or Ctrl + S) 

 

File → Open Final Image in External Program  

If you would like to continue editing your current image in another program, 

you don’t even need to leave NATURE projects. For this, simply click on 

Open Final Image in External Program. 

 

File → Print Final Image  

Click here to print the image result. The image is automatically correctly 

scaled to and centred on the print medium.  

 

File → Post Result Image to the Clipboard  

The current image is posted to the clipboard from which it can be seamlessly 

inserted into other programs. 

 

File → Projects  

If you have already begun editing a project in NATURE projects and would 

like to continue working on it, open the file by clicking Projects. 

 

File → Quit  

Click on Quit (or Ctrl + F4) to close NATURE projects. 
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6.2 Edit 

 
 

Edit → RAW-Development  

Whenever you want to easily edit a photo, simply click on RAW Development 

to do things like alter colours in a photo or distort the image (please see 15. 

RAW Image Editing). 

 

Edit → Post-Processing  

Once you have uploaded an image you are officially in Post-Processing. 

 

6.3 View 

 

View → Full Screen View On/Off  

If you ever feel dis-

tracted by the task bar, 

toggle between a 

normal and full-screen 

view by clicking on Full 

Screen Mode On/Off. 

 

 

 

View → Interface Style… (Individual)  

Click on Interface Style will allow you to alter the colour scheme in NATURE 

projects. The current colour scheme selected is displayed in brackets. 
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View → Font Size   

Adjust font size levels for menus and headers between small, medium or 

large. 

 

View → Window Reset  

Returns the current window to its original size. 

 

6.4 Extras 

 

Extras → Preparing Image   

Here you can prepare your image 

prior to entering Post Processing 

(please see 7. Image Preparation). 

 

Extras → Settings (Ctrl + P)  

Here you will find the various con-

figuration options available in NATURE projects for adjustment to your 

personal preferences. 

 

Program: Program Paths 

Here you can designate project, image and final image file save storage loca-

tions. 

 

Program: Language 

Here you can change the NATURE projects program language to German, 

English or French. 
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Program: GPU Acceleration 

Here you can either activate or deactivate accelerated computing speed using 

the graphics card. 

 

Program: Tooltips 

Hovering your cursor long enough over specific tools or menu options will 

prompt the display of a short text offering an explanation of the function. 

This is called a tooltip. Tooltips can be deactivated here if preferred. 

 

Program: Progress Bar 

When creating effects in NATURE projects, the program helps to visualize 

the progress of this computation using the Progress Display. Here you can 

decide when and whether to display the Progress Display. 
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Program: Undo 

With the option Save Undo Steps in Projects, you can save all undo levels 

within the project file. These are then fully restored upon loading. This results 

in the creation of noticeably larger project files. Set a limit for the maximum 

number of Undo Steps (1, 5, 10, 20 or 50). If you do not wish to set a maxi-

mum limit on undo layers, select “unlimited”. Minimum free disk space 

specifies the amount of free disk space that will not be taken up for saving 

undo layers. This guarantees the proper functioning of your operating sys-

tem. The default amount takes up 10% of hard disk capacity and can be 

increased or decreased according to your preferences. 

Export 

 

 

External Programs 

Here you specify which export format is used for exporting NATURE projects 

images to external programs. You can also designate which programs are to 

be used for external program editing.  

Navigate to and select the folder to which the application has been installed. 
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File Save Formats 

 

 

Jpg 

Jpg or Jpeg is the most widely used and well-known image file format for 

cameras and editing software. Here you can adjust image quality and carry 

out file compression. High- quality compressed images look better but take 

up more storage space. 

 

Tif 

Here you can choose between a number of compression procedures used to 

compress Tif files. 

 

Png 

Png is especially popular for graphics and digital visualization. Here you can 

choose from a variety of compression processes. 

 

Automatic Functions 

 

Confirmation Windows and Additional Information  

Here you decide whether or not to continue to display confirmation windows 

or additional information. 
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Automatic Undo Points 

Automatically creates an undo-point prior to RAW development, sensor error 

correction and selective painting. This creates an initial starting-point for your 

project directly after loading the image which you can return to at any point 

during the editing process.  

 

Image Preparation 

If a checkmark is left in the „Display Image Preparation at Plugin Import“ 

checkbox, the image preparation window will show when images are export-

ed using a plug-in (e.g. from Photoshop). Remove the checkmark if you do 

not want this window to appear following each upload. 
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Image Saving 

Activating this option will display the cropping window prior to saving the 

image. 

 

Extras → Save Undo Point (Shift + Z)  

Use the Save Undo Point (or Shift + Z) function to save your image in its 

current state (without saving to the file) and continue working. You can al-

ways return to the last saved version of your image at any time. 

 

Extras → Timeline (Ctrl + T)  

Click on the Timeline or (Ctrl + T) to display all Undo Points. 

 

6.5 Add-ons 

 

 

Addons → Import Add-on  

With the help of Add-ons, you can now not only import Presets into NATURE 

projects but also integrate new Post Processing modules, giving your Presets 

an entirely new look.  
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Addons → Remove Add-on  

Remove an add-on using this button. 

 

Addons → Add-on Information  

Here you are provided with a display of all information regarding Add-ons 

currently in use. 

 

6.6 Information 

 

 

Information → NATURE projects – Homepage  

Click here to navigate to the NATURE projects homepage. 

 

Information → Show Keyboard Shortcuts…  

Here you will find all keyboard shortcuts available in NATURE projects. 

 

Information → Supported RAW Formats   

A list of all cameras for which RAW files are supported and can be opened in 

NATURE projects. 
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Information → Update Check   

Checks online whether newer versions of the software are available for 

download.  

 

Information → About NATURE projects (Shift + F1)  

Information about the current version, 3rd party software and NATURE pro-

jects credits. 
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7. Image Preparation 

Here you can precisely configure the image preparation settings: 

For the first steps, select the default setting. Changes can always be 

reversed by clicking on the backwards-pointing arrow (bottom left): 

There are no irreversible mistakes.  
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a. Scaling: When uploading bracketed series, images can be 

scaled from 25% up to 400% using any one of the 6 different 

scaling processes available. As a general rule: The further 

down these are in the list, the better the image quality and 

longer the computation time. 

 

b. Colour Space Conversion: Ad-

vanced users can select a col-

our space here – beginners are 

recommended not to activate 

this option as to avoid incorrect 

colour output. NATURE pro-

jects now offers a new colour 

spectrum (D65). Standard 

Light D65 is representative of a 

phase of natural daylight pos-

sessing the colour temperature 6500° Kelvin. 

 

c. The White Balance corrects colour casts caused by the 

warm lighting of a room present when the photograph was 

taken. Leave this checkbox unchecked at the start. 

 
d. With this slide control, you can already begin to adjust the 

Colour Temperature upon loading your image. Recom-

mended here is leaving the setting at “Default” and the mak-

ing adjustments to the colour temperature later within the 

Post Processing settings. 
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e. Optimisations: Use the Normalise Colour option to auto-

matically remove pre-existing colour casts present in RAW 

images. This function ensures that shadows appear black 

and lights appear white. The Automatic RAW Luminosity 

Optimization function can be activated for RAW file up-

loads in the RAW options section. Camera RAW formats of-

ten do not make use of all potential tone values. Automatic 

RAW Luminosity Optimization compensates for this by en-

hancing the tonal values resulting in the creation of a more 

comprehensive histogram for each RAW image. If the 

checkbox beside Automatic Rotation of Images is filled, 

images are corrected according to the orientation present in 

their Exif data. 
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8. Post-Processing: Presets 

We enter Post Processing directly after 

loading the images. Edit your results by 

applying filters or effects to your images. 

Left Side of the Post Processing Screen:  

Upon entering post processing, you will 

notice that the filter „Balanced” has been 

selected. Click on the preview images and 

the effects are applied to the images in 

real-time.  displayed in the middle of the 

screen.  

NATURE projects isn’t about image looks, 

but preliminary presets. 12 different ef-

fects make your image lighter, darker, 

more vivid in colour, etc.  
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Image with the Preset „Light“. 

 
 
Image after applying the preset „Dark“. 
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All 12 NATURE projects preset at a glance – easily undock the „De-

fault Settings“ bar and adjust its size accordingly. 

 

 The Variant Browser 

 

The Variant Browser provides a visualization of an array of vari-

ous function variants and is primarily controlled using the 

mouse: 

 Move the Screen: Hold down the left mouse button 

and move your cursor  

 Zoom in: Mouse wheel upwards 

 Zoom out: Mouse wheel downwards 

 Select Variant: Double left click the desired image 

 Set as reference: Simple left click of an image 

 Compare with reference: Hold the right mouse button 

over an image 

 

The list of corresponding keyboard shortcuts can be accessed in 

the menu „Menu Information -> Display Keyboard Shortcuts”. 
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Click on the corresponding symbol and NATURE projects dis-

plays all preview images for a selected category. Zoom in on the 

variant you wish to compare and designate it as a reference im-

age.  

 

Select any image as a reference simply by left-clicking an image. 

Display this reference by holding down the right mouse button 

over a different image. The green dotted line - - -  outlining the 

border denotes the reference image selected for use in the 

comparison. 

This allows you to make a direct visual comparison of two sepa-

rate variants within the browser. 

 

Example: Select the variant „Light“ as a reference image by left-

clicking the image. The green dotted line indicates this selection. 

 

 
 

Now select a different preview image. For our example, the pre-

set „Dark“ has been chosen.  
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Now right-click the preset „Green Filter“ to display the refer-

ence preset. Once the mouse button is released, the “Green Fil-

ter” preset reappears. Use this function for the targeted selec-

tion and comparison of various image looks. 

 

Selecting your preferred Variant:  

Select the variant you wish to use with a double-click. The pro-

gram settings are applied automatically. 

 

Tip: 

Your current selection is automatically set as the reference im-

age upon opening the browser. 

 

Remove a Variant: 

If you would like to remove a variant, hover your cursor over the 

variant and press the [Del] key. Now click the “Compress” but-

ton. If you wish to display deleted variants again, click on „Re-

set“. 
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 Create Restore Point  

The Create Restore Point function can be used to save your work 

at particular stages during editing, display these along the time-

line and return to any point of your choosing. 

 Timeline  

The Timeline lets you view and access all saved restore points 

throughout your project. 

 

 Compare Window 

 

 
 

 Activate Left/ Right Comparison 

 Activate Top / Bottom Comparison 

 Activate Top-Left / Bottom-Right Comparison 
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 Activate Bottom-Left/ Top-Right Comparison 

 Swaps „Before“ and „After“ in the Compare Window 

 Activate/deactivate Luminance Display. 

 Switch between the three different Luminance Display modes: 

„Two Selective Areas for Shadow and Light“,  „From Area 1 to Area 2“ 

and „Outside of Area 1 and 2“. 

 

Slide the two luminance areas values from 0% (black) to 100% (white) 

along the luminance bar. 

 
 

You can also dock the Compare Window to the left and right side 

panels underneath „Default Settings“ or „Finalise“. 

 

Want to compare with the original image? Simply right-click on the 

middle of the image for a display of the before/after result. This 

ensures complete control throughout each stage of editing at all 

times. The Compare Window provides a more in-depth overview 

with selectable areas and luminance display.  

 Histogram  

The Histogram displays the distribution 

of tonal values within your image.  The 

cumulative Histogram shows how ele-

ments of colour and luminance are 

distributed throughout your photo. A 

flat cumulative histogram represents a 

brighter image; a bulge in the curve 

indicates a much darker image. The Histogram can be enlarged by 

clicking on it. 
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 Real-time Calculation 
 

With this option activated, all changes made to the default 

settings are immediately applied to the image allowing you to view 

the immediate effects of your changes. If this option is left deactivat-

ed, changes are only displayed after clicking the “Recalculate“ button: 

 

 

 

 The „Original Resolution View“ Symbol 
 

This button sets the zoom factor to original resolution. 

 

 „Set Zoom to Monitor Size“  

This symbol sets the zoom factor to the maximum possible screen 

size. 

 

 

 Filter Presets 

Find presets much quicker by entering “filter” in the Filter Search 

Window to the left. Only those select filters which feature the string 

“filter” are displayed – that is, presets with Pole Filter, Gradient Filter 

or Red Filter included in their name. This vastly simplifies your 

search. 
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9. Post-Processing: Finalise  

Thus far, we’ve dealt with the first essential element of Post Pro-

cessing. Now it’s time to get 

to the fine-tuning (tools on 

the right side of the screen 

under „Finalise“). 

 

 Magnifying Glass 

On the right side (all the way at the top) of the Post Processing menu 

you will find the 1:1 Magnifying Glass. This tool shows the area sur-

rounding your cursor in a 1:1 pixel display of this section within your 

image. 

 

 

Click on the „Comparative View“ button to display the recently im-

plemented compare window. This provides a side-by-side view of 

your edited image alongside the original. Examine the comparison in 

greater detail by with the magnifying glass. 
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Fix the magnifying glass on a particu-

lar region of your image simply by 

pressing the „L“ key while moving 

your cursor across the image. Re-

lease the fixed region by pressing the 

L-key once more. 

          

Click within the magnified image region to toggle between the dis-

play options „Split Before/After Comparison“ and „Direct Be-

fore/After Comparison“. 
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 Point of Interest    

Activating „Point of Interest“ will make it so that edits made to your 

image are only applied to specifically defined regions of your photo-

graph – effects are displayed in full resolution for these areas; re-

maining regions are excluded. This function proves especially useful 

for very large photos at high resolutions, e.g. panorama photos. 

 

 

 Optimisation Assistant 

 

 

The optimisation assistant is an effi-

cient tool for creating fascinating edit-

ing results quickly and easily. 

With the default setting is activated, 

enter correction values for Denoising, 

Tonal Value, Clarity, Dynamic and 

Sharpness by adjusting the slide con-

trols for level intensity. Changes are 

applied in real-time.  
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The optimization assistant is intelligent: It remembers the edits you 

make and applies the correction values using to the next image in 

the same manner – this time adjusted to fit the new theme of your 

photograph.  

The assistant can be deactivated if you care to edit your photos 

without the Image Assistant. To reset the values the assistant has 

„learned“ so far, click on   

Additionally, you can give the 

assistant optimization tem-

plates formed on the basis of a 

specific image style: Select from 

the presets „natural“, „naturally 

cool“, „naturally warm“, „soft“, 

„fine “ „brilliant“, „intense“, 

„sober colours“, „colourful“, 

„High Key“ , „Low-Key“ and 

„Low-Key colourful“. 

 

 

 Optimisation Assistant: Opacity Slide Control 

Opacity is turned on 

automatically once 

there is at least one 

optimisation active.  

The opacity affects the results of each image optimising effect as well 

as the optimisation default settings. 
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Tip: 

Try setting the optimisation preset to „High-Key“ with the opacity 

level of around 40-60%. 

 

Professional Tip: Keep in mind that the optimisation templates set 

forth by the presets and the optimisation assistant combine: If you 

choose the preset „Dark“ and the optimisation “naturally cool”, the 

result will be a dark image with a cool colour mood. This is no prob-

lem at all. Change the optimisation to „natural“ to restore the normal 

look of the preset. You can also quickly switch between intense, 

saturated and high-key/low-key looks and gather new creative ideas.  
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10. Local Adjustments/Selective Painting 

 

The selective drawing tool in NATURE projects deserves special 

consideration. This tool enables the user to selectively edit specific 

image regions without the trouble involved with manually creating 

complicated masks as common in other image editing programs. 

NATURE projects has been equipped with a recently developed 

intelligent edge recognition algorithm able to automatically detect 

edges, lines, borders and variance in brightness within the image 

while in selective drawing mode. This algorithm then saves the re-

gions you’ve selected with your cursor as a mask. These easy-to-

create yet precise masks serve as the basis for 10 useful image im-

provements: „Show Original Im-

age“, „Shading“, „Illuminating“, 

„Intensify Colour“, „Reduce Col-

our“, „Strengthen Details“, „Reduce 

Details“ und „Sharpen“ etc.  

These masks can even be saved as 

their own image files for further 

use in other image editing pro-

grams. 

How the whole thing works is best explained using an example: 

Open the selective drawing window (Post-Processing/Finalise – bot-

tom right). Serving as our image example is a single RAW file, a photo 

of a rocky coast. The colour details in the image have already been 

thoroughly developed.  
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Now we would like to slightly darken the rocks without taking away 

from the morning atmosphere within the picture – the water and sky 

should remain untouched. 

 

 

 Finished Image Edits in no time with Selective Painting 

1. Select Editing Objective 

Select „Shading“ . Ensure 

that the mask function se-

lected is activated with the 

display of the green 

checkmark next to the func-

tion.  

 

2. Activate Drawing Mode    

3. Activate Fill Mode for all brush functions   
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4. Glide your mouse over the contours within the image with-

out clicking the mouse button. The brush size is clearly dis-

played and may be adjust-

ed accordingly.  

5. Pay attention to the mask display. The objects displayed 

white are those for which the system has successfully de-

tected borders. Now draw along the edges of your chosen 

object while holding down the right mouse button until the 

entire object has been selected.  

NOTE: What you see now is the effect and the overlaying mask. 

 

 

6. Once you have finished making the selection, hide the mask 

by dragging the slide control for mask display to the left or by 

pressing the “M” key on your keyboard. 
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7. Notice the effect in the brightness of the rocks – initially cho-

sen as an editing objective was “Shading”. Now adjust the in-

tensity of the effect by moving the slide control in either di-

rection (+ / - ) depending on the desired level of intensity. Fin-

ished: The rocks are brighter while the sky, beach and water 

have remained untouched.  

8. Click on “Close”. You are returned to Post Processing and the 

selective edits are applied. 

 

 

 

 

 

9. Use your quickly created mask for an additional effect: Re-

turn to Selective Drawing mode. The mask just created has 

been preserved.  

Notice how much darker the rocks appear on the right side displaying 

the image  

following selective correction. The sky and sea have the same exact 

tonal values as before. 
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10. Click on      and copy to the mask to clipboard. Change 

the mask to „Sharpen“ and insert it from the clipboard by 

clicking on the  button. Now you’ve only sharpened the 

rocks; other sections of the image remain untouched. 

11. Each selective effect created can be either activated or deac-

tivated using the green checkmark. 

12. Edge intensity varies from photograph to photograph. The 

default settings are usually enough to get the job done. 

However, from time to time it may be necessary to make ad-

justments to the contours and softness in order to achieve 

desired results. 

 

13. If you happen to draw outside the lines despite using edge 

recognition, use the eraser  to make corrections. If you 

only wish to erase small areas, use the Eraser with Limita-

tion. With opacity set to 50%, this means you can only erase 

50% of the mask no matter how often the eraser is used on 

that select area of the image. Drawing Mode with Limitation 

functions in the same manner: Any changes made with the 

tool will not exceed the opacity level specified in the limita-

tion. 
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14. If you would like to mask everything within an image except 

for a small object, the best way to go about doing this is to 

mask the small object and then reverse the mask. To do 

this, click on  .  

 

Professional Tip:  You have two types of fill modes at your disposal 

for filling masks. When should you use which? The “Normal” Fill 

Mode   was used in our example covering masking large areas. 

This is also the fill mode recommended for use on sky and water. 

 

Functions and Capabilities in Selective Drawing 

- Selectable Mask Colour 

Select a colour for the mask display and brush from the selection.  

 

 

Display of your selected colour is updated in real-time. 

- Selective Drawing - Creating a Mask  

Masks can also be created using specific colour tones or levels of 

brightness. 
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Activate (Create mask) mode with button (1) and you find yourself in 

the „Create Mask from Colour Tone“ mode (2). If you wish to create a 

mask using brightness levels within the image, choose button (3). 

The Tolerance Slide Control determines how sharp (low value) or 

how soft (high value) mask pixels are calculated. 

While in (Create mask) mode, the cursor turns into a pipette and the 

image colour/brightness level underneath your cursor determines 

how the image is masked. 

 

In the example above, we can see how a mask (red mask display) has 

been created using the colour tone of the sky. 

Tip: 

If you would like to incorporate multiple colour tones into one mask, 

simply click on each of the colour tones one after the other within 

the image using the pipette tool. Each click of a colour tone adds this 

to the mask. 
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- Selective Drawing – Smoothing Brush 

The Smoothing Brush (1) allows you to smooth certain areas of the 

current mask.  

 

In order to soften a certain area even more, simply run the Smooth-

ing Brush over this section of the image repeatedly. 

- Global Mask Functions 

In the Global Mask Functions section, you will find an array of special 

processing modes. 
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1.  Minimize entire mask outline  

 becomes    

 

2.  Enlarge entire mask outline  

 becomes  

 

3.  Smooth entire mask  

 becomes  

 

For each of the global functions you will find two buttons – the left 

button applies the function with lesser intensity and the right button 

with greater intensity. 
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- Resetting the Function of a Mask  

Each mask can be reset to default values without affecting other 

active masks. This is done by clicking the trash button (1). 

 

After clicking the Mask Reset button a confirmation window will ap-

pear in order to prevent the accidental deletion of important work. 

 

- Automatic Mask Adjustment to RAW Module Distortion 

Correction 

Selective Drawing and the RAW Module operate in conjunction. This 

includes the RAW Module’s Distortion Correction which can be au-

tomatically applied to all of your drawn masks. 
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In the example above, we have an image in which the sky has al-

ready been masked. 

 

When additional corrections are made to the horizon from within the 

RAW Module, the mask created for the image is automatically ad-

justed to the distortion correction. 
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11. Composing Mode 

Composing Mode within Selective Drawing allows you to add up to 

four layers of additional images to your current project. 

 

Switch to Composing Mode by acti-

vating the „Composing“ button (1). 

 

From the selection (2), choose which 

composing layers you would like to 

edit. 

 

Use button (3) to activate the cur-

rently selected mask and button (4) 

to load any image of your choosing 

as a new layer. 

 

You can upload RAW, Jpg, Tiff, as 

well as a variety of additional image 

file formats. 

Underneath the image display you 

will find the Parameter Area, the 

beginning of which is marked by the 

two buttons for the following func-

tions:  
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(5) Multiple Applications 

If the layer of the image is scaled smaller than the image you are 

currently working on, use this option to extend the image outwards 

(up, down, left, right). 

(6) Set Aspect Ratio  

Since the aspect ratios of upload images often differ from that of 

your current image, this function allows you to define the aspect 

ratio for the uploaded layer in order to retain its proportions. 

(7) Horizontal Flip 

This function can be used to flip the image layer horizontally. This 

allows you to more precisely adapt the layer to the current image 

without having to switch between layers. 

(8) Vertical Flip 

This function can be used to flip the image layer vertically. This al-

lows you to more precisely adapt the layer to the current image 

without having to switch between layers. 

(9) Parameter Slide Controls 

Aspect Ratio: If the aspect ratio hasn’t been defined using button 

(6), you can always also make resizing adjustments by hand. 

Zoom: Choose the size of that image level by zooming in or out. 

Slide Horizontally: Move the layer image left or right. 

Slide Vertically: Move the layer image up or down. 

Exposure: Exposure levels in your current image may not always 

correspond with the exposure in layer image. This function can be 

used to conveniently adjust the image exposure for a certain layer. 
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A night shot with a very vibrant sky...  

 

…can be transformed into a real eyecatcher within minutes 

using Composing. 
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12.  Remove Scratch/Sensor Errors  

 

This easy-to-use correction function from NATURE projects helps 

you remove unwanted sensor errors. This process may also turn out 

to be a good deal of fun! 

Professional Tip: The intelligent Correction Function isn’t only capa-

ble of erasing sensor errors but can also be used to eliminate other 

distracting objects in your photograph - popular vacation spots were 

never free of beachgoers so fast! 

Stamp errors directly out of your photograph – the program will 

automatically replace these areas with visually similar segments 

from elsewhere in the image.  

 

 

 

 

 

 

 

 

 

 

The sensor errors in this photograph have been circled red.



NATURE projects – User manual 

 

67 

For making corrections, proceed as follows: 

Select the Brush Tool from (6) and click on the spot within the image 

you wish to correct. Following your selection, a dotted circle will 

appear next to your cursor serving as a source.  

Move this circle to any position with-

in the image you wish to serve as the 

source for the first correction mark-

er. The designated position is then 

improved using this source selection.  

Display the sensor errors beforehand 

using the Contrast View button (1). 

These appear brighter within the 

image.  

Display or hide image improvements 

using button (2). Corrections are 

applied even when hidden and primarily serve as an overview for 

before/after comparisons.  

Select multiple correction areas by clicking on the brush symbol (6) 

and adding new area(s).  

Use button (3) to show/hide correction area targets.   

Button (5) deletes all corrections made. 

Section (7) is used to adjust the size of the selected correction areas.  
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You have the additional option to execute an automatic search for 

the best correction source area within the image. For this, click the 

button (8).  

Button (4) is used to apply the appropriate changes to correction 

areas placed in automatic mode using button (8).  

Use button (9) to delete the selected correction area.  

 
 

During Sensor Error Correction, the software highlights errors and de-

termines which similar segments of the image serve best to replace the 

error spots. 
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Sensor Error Correction has been successful. 
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13. Workflow 

 Continue Editing your Project in External Programs 

NATURE projects offers interfaces to external programs. After suc-

cessfully completing your initial edits, this lets you continue to make 

further changes in another image editing program of your choice. 

 

 Open Projects in other Projects Programs 

Click on the Projects symbol in the menu bar to open your image in 

another Projects Series program. From the programs already in-

stalled on your computer, select which program you want to open 

your image in from the drop-down selection to the right. 

 

 

 Open Projects in other Photo Editing Programs 

To open your image directly in another photo editing program such 

as Adobe Photoshop, click on the symbol highlighted below and 

choose a program from the list.  

You can also enter editing program path in the settings beforehand.  
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Click on „Extras“ within the menu bar and select „Settings“ from the 

context menu: 

 

Next, click on the tab labelled „Export“. Here you can designate file 

save locations for external editing programs. 
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 Working with the Timeline and Restore Points 

This option can also be found in the menu tab at the top of your 

screen: 

 

Clicking the „Create Restore Point“ button lets you create a tempo-

rary save point for all currently active settings. This way, you can 

always return to any previous editing stage of your choice while 

saving as many restore points as you need. These save points are 

displayed along the Timeline allowing for quick and easy access to 

any editing stage with a simple click of the mouse: 

 

 

 

This function is especially useful for testing the outcomes of addi-

tional effects and settings on your image. Just create a restore point 

and continue editing. If you would like to return to a save point, click 

on the symbol     within the Timeline. Use the  button to add 

your own notes as a header. 
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14.  Selecting and Saving Sections of 

Images 

Save final images also using buttons found within the toolbar, from 

the file menu or the appropriate keyboard shortcut (Ctrl+S). 

 

 Cropping and Title 

Upon initiating a save command, the Cropping and Title window will 

open. If you do not wish to crop or add subtitles to the image, click 

on “Save”.  

 

In the above section of your screen you will find a collection of prac-

tical layout and composition tools for adding the finishing touches to 

your image. 

Determine the aspect ratio and display helplines such as the Rule of 

Thirds, Golden Ratio and the Golden Spiral. Also useful is the display 

of the Centre Marker accessed using this button          
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The final image is displayed at the centre of screen. Select the save 

region by adjusting the corners or sides.  

Enter captions in the section below. Specify the font size, back-

ground as well as the position of the text within the image. 

The font size is automatically adjusted to the select aspect ratio. 

Free crop your image, maintain the original aspect ratio or enter 

your own dimensions. You can also select from any of the available 

71 format templates. 

 

Please note that for a chosen aspect ratio of 13 x 18, the dimensions of 

the final image are not equal to 13 x 18 cm, rather the image is saved in 

a ratio of 13 x 18. 

 

Once you have cropped and added subtitles to your image, confirm 

these changes with the „Save“ button to continue to the next window 

where you can specify a file save format and enter a save name. 
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15. RAW Image Editing 

Process and edit raw image data using the integrated RAW Module 

complete with a comprehensive collection of editing tools such as 

Denoise/Sharpen, Exposure, Colour, Details as well as Distortion 

Correction. 

 

Category Reset  

Each category can be returned to its default settings using the Reset 

Button (bottom left) without effecting additional category settings. 
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The RAW Module: Essential Functions Overview 

White Balance: Here you can adjust the colour temperature within 

your image. Use the Pipette tool to sample the white balance directly 

from the photograph.  

Denoising/Sharpness: This setting controls noise properties and 

image sharpness levels. Make changes to the image quality and vari-

ous noise types such as Chromatic Noise, Banding and Hot Pixels. 

Colour Balance: The focus here lies Colour Balance and Colour Cor-

rection. Alter the general colour mood and neutralise colour balance 

– these adjustments add the final touch to professional colour cor-

rection. 

Exposure: Make changes to the Shadows, Lights, Contrast and Bril-

liance in your image. Make individual adjustments to brightness 

levels adapted to your specific image focus. 
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Detail: Changes made to Clarity and Micro-Details are further divid-

ed into adjustments in Shadows, Lights and Middle Tones. 

Colour: These colour settings control luminosity levels in lights and 

shadows. Also use these to counteract unwanted chromatic aberra-

tions. 

Light diffraction enables the precise removal of chromatic aberra-

tions of a specific colour. This involves the inverse calculation of 

object curvature of a selected colour channel. 

Palette: Adjust saturation levels of individual colours using the Pal-

ette. 

Distortion: This setting deserves a closer look. With this mighty tool 

you can straighten the horizon, correct camera rotations and lens 

errors. Crop out uneven edges with „Autofit“.  

Helpline grids can be displayed in grid-form or transparently to suit 

your specific needs. This way, you retain maximum oversight when 

correcting image distortions. 
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 The FX Category: 

 

Contained in this category 

are special effects such as 

Haze and Fog, Save High-

lights, Sepia, Film Grain as 

well as a number of addi-

tional brightness gradients. 

Professional Tip: 

Set the slide control „Gradi-

ent Top“ to a dark value in 

order to create a neutral 

density (ND) filter. 

 

General: Activate the “360° 

panorama mode” to optimise 

matching edges of images in 

a panorama series. Save 

your settings as a camera 

profile to save time in the 

future. This can be reset at any time.    
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Once finished making changes in RAW Mode, click on “Apply“. 

Saving your image edits in camera profiles for future work can save 

loads of time. The saved profile can be deactivated or reset at any 

time.  

 

 

Add your own Camera Profile  

You have the additional possibility of adding your own camera pro-

file. For this, click on  . Personal camera profiles can be given 

their own name and possess all the same capabilities as camera 

profiles created automatically. If you wish to delete or rename an 

existing camera profile, right-click on the camera profile from within 

the drop-down profile selection. 
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Zoom and Brightness 

At the top right 

you will find the 

slide controls for 

Zoom and Bright-

ness of Image 

Display.  

Note: With the Brightness of Image Display slide control you are only 

adjusting the brightness of the program display screen and not that 

of the image itself. 

 

Histogram 

The Histogram can be found underneath the slide controls.  

RGB: Display of image RGB values at your cursor’s location within the 

image. 

HSL: Display of image HSL values at your cursor’s location within the 

image. 

Note: HSL stands for Hue, Saturation and Lightness.  
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16. Using Plug-ins 

NATURE projects offers the capability of using the software togeth-

er with an added Filter Plug-in for Adobe Photoshop. Current Pho-

toshop versions are automatically recognized by NATURE projects 

during installation on Windows and the Plug-ins installed and saved 

to the corresponding plug-in folders. Older versions of Photoshop 

may require manual plug-in installation.  

 

If you have either purchased the downloadable version of the soft-

ware or misplayed lost your CD-ROM, download plug-ins directly 

from www.projects-software.de/plugins.  

16.1 Using Photoshop Plug-ins on Windows  

The following window will appear during NATURE projects installa-

tion: 

 

Choose the Photoshop version from the list for which you would like 

to install the NATURE projects Plug-in. Click “Continue” and follow 

the further installation instructions. The plug-ins are then automati-

cally installed. 
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Please note: When using older Windows systems, it can be that not 

all plug-ins are automatically installed. Should this occur, simply copy 

the preferred plug-in directly into the current Photoshop version 

folder as shown in the picture below. If you are using an older ver-

sion of Photoshop, simply copy the plug-in nearest to the bottom. 

Example: Photoshop CS6 users should copy the plug-in for Pho-

toshop CS6 and not Photoshop CC 2014. In this case: CC 2017. The 

corresponding plug-in can be found on the CD-ROM under “Plugins”. 

Users in possession of a download version of the software can find 

these under C:/Programs/Franzis/NATURE projects. 

The folder can be found under C:\Programs\Adobe\Adobe Pho-

toshop CC 2018\Plug-ins  

 

Plug-ins can also be installed at a later point in time. Please install 

Photoshop before attempting to install the plug-ins! Following 

plug-in installation, please reopen Photoshop.  

In Photoshop under the menu tab “Filters”, you will find the selection 

option FRANZIS. All plug-ins from the projects collection can be 

found listed here. 
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Click on NATURE projects. The image opened and edited in Pho-

toshop will now be opened in NATURE projects.  
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The program has now entered Photoshop Filter plug-in Mode. You 

can edit the photo in NATURE projects just as usual. Once finished 

editing, you can send the finished version back to its original Pho-

toshop layer by clicking “Apply”.  

 

The “Cancel” button closes the Filter plug-in without returning the 

changes made to the image to the Photoshop layer. Changes made 

in NATURE projects are therefore discarded. 

The Projects program in use then closes – an action strictly required 

by Photoshop. 
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16.2 Using the Photoshop Plug-in - MAC OS X 

The Plug-ins can be found located within the „Plug-ins“ folder on the 

start screen. Select the folder corresponding to your current Pho-

toshop version (CS6 is chosen in the following example). Double-click 

the .zip file to unpack the Plug-in. 

 

Next, transfer the unpacked plug-in NatureProjectsFil-

ter_PH6.plugin (PH7 for more recent Photoshop versions) using a 

drag-and-drop into the plug-in folder for your Photoshop version. In 

most cases this is labelled “plug-ins”: 

 

Start your Photoshop version, upload your image and navigate to 

„Menu Filter Franzis NATURE projects“ 
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Click to open the plug-in and the image is opened in NATURE pro-

jects. 

 

The program is now in Photoshop Filter Plug-in mode. Edit your pho-

to as usual in NATURE projects. 
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Afterwards, click the “Apply” button to send the finished photo back 

to the Photoshop source layer. 

 

With „Cancel“ you can quit the filter plug-in without sending your 

changes back to the Photoshop layer. These edits are not saved in 

NATURE projects. 

 

The Projects program in use then closes – an action strictly required 

by Photoshop.  
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16.3 Using the Adobe Lightroom Plug-in - Windows 

 

Start the installation program while ensuring that component 

„Lightroom Plugin“ has been selected.  

 

Should you not have the CD on hand, download the plug-in from 

www.projects-software.de/plugins   

 

The Lightroom version will then open. Start Lightroom and navigate 

from „File Plug-in Manager “ in order to check whether the 

Plug-in is activated. 
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Should this not be the case, you have the additional possibility of 

manually installing the Lightroom Plug-in. To begin, click on the 

„Add“ option found in the Plug-in Manager. 
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To do this, locate the Lightroom folder containing the Plug-in NA-

TUREProjects.lrplugin  

 

Once inside the NATUREProjects.lrplugin folder, click „Select Folder“ 

to install the Plug-in for Lightroom.  

 

Lightroom: NATURE projects: Installing and running.  

 

Select a bracketed series within your Lightroom library.  

 

Right-click the highlighted images and select the option „Export 

Export to NATURE projects“. 
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Or: Select „File Export with Preset  Export to NATURE 

projects“. 
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16.4 Using the Adobe Lightroom Plug-in - MAC OS X 

The plug-in for Adobe Lightroom is not installed automatically when 

using MAC OS X. Follow the steps below to add it to Lightroom:  

Install NATURE projects to the program folder on your Mac.  

Copy the Plug-in ZIP from the folder “Lightroom Plugin“ where your 

presets are also stored on the CD:  

„User/Username/ NATURE projects“. 

Start Lightroom and navigate to „File    Plug-in Manager“ 
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Click on “Add“ option within the Plugin Manager. 



NATURE projects – User manual 

 

95 

 

Select the corresponding Lightroom Plug-in from NATURE projects 

just copied to your Mac.  

 

Should the Plug-in not immediately display the green active indica-

tor, close and restart Lightroom. 



NATURE projects – User manual 

 

96 

 

Now install and run the plug-in.  

You can transfer your image from Lightroom to NATURE projects 

using one of a number of different methods.  

„File Export with Default Export to NATURE projects“. 
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OR:  

 

Right-click the highlighted image and select the option „Export 

Export to NATURE projects“. 

 

 



NATURE projects – User manual 

 

98 

17. Keyboard Shortcuts 

Integrated Keyboard Shortcuts - Overview 

An overview of keyboard shortcuts can be found in the main menu 

under Information. 

 

Click on the menu option to open the summary. 

 

Within the shortcut summary, you can scroll through each section.  

At the bottom left you will find the button „Open in Browser“. This 

saves the keyboard shortcuts as an html. file and opens these in 

your standard browser.  
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General: 

Windows Apple 

Ctrl N  cmd N New Project 

Ctrl Shift O  cmd Shift O  Upload Single Image 

Ctrl O cmd O Upload Image Sequence/Bracketed Series 

Ctrl S  cmd S  Save Image Result 

Ctrl D  cmd D  Print Image Result 

Shift Z  Shift Z  Create Undo-Point 

Ctrl T  cmd T  Open Timeline 

Ctrl F4 cmd F4 Quit Program  

F4 F4 Open RAW Module 

F7 F7 Switch to Post Processing 

Ctrl P  cmd P  Open Settings 

@ @ Access Homepage 

Shift F1 Shift F1 Open About Dialogue 

Ctrl H  cmd H Show/Hide Histogram  

Ctrl F  cmd F Full Screen View  

Image Display Functions: 

Windows Apple 

Ctrl+ cmd + Zoom in 

Ctrl - cmd - Zoom out  

Ctrl 0 cmd 0 Fit Image to Screen 

Ctrl 1 cmd 1 100% Display View 

R  R Real-time Mode on/off 

L  L Configure Radar Window (lock) 

RAW Development: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd + Zoom out  

 

Progress Browser: 
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Windows Apple 

Image up  Image up Back one page 

Image down  Image down  Forward one page 

Pos1 key  Pos1 key  To the Beginning 

End key  End key  To the End 

Cursor left  Cursor left  Previous Item 

Cursor right  Cursor right  Next Item 

Variant Browser: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd - Zoom out  

Cursor left Cursor left  Shift View to the Left  

Cursor right Cursor right Shift View to the Right  

Cursor upwards Cursor upwards Shift View Upwards  

Cursor downwards Cursor downwards Shift View Downwards  

Ctrl 0 cmd 0 Show All  

Space Bar Space Bar Center View 

Enter Key Enter Key Select Item 

X X  Compress View 

Pos1 key Pos1 key Reset View 

 

Sensitive Selective Painting: 

Windows  Apple 

Ctrl +  cmd + Zoom in 

Ctrl -  cmd -  Zoom out 

Ctrl O cmd O 100% Display View/Adjust Fit  

A  A Activate Brush Tool  

Shift A  Shift A  Activate Brush Tool with Limit 

S S Activate Eraser Tool 

Shift S  Shift S  Activate Eraser Tool with Limit 

W W Activate Blur Tool  
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E  E Activate Image Mask Creator  

D  D Activate Fill Mode  

F  F Activate Brush Fill Mode  

R  R Activate Brush Streak Mode  

1 1 Reduce Brush Size 

2 2 Increase Brush Size 

3 3 Reduce Opacity  

4 4 Increase Opacity  

5 5 Soften Outline Recognition 

6 6 Sharpen Outline Recognition 

7 7 Reduce Blur  

8 8 Increase Blur  

Ctrl Z  cmd Z Back One Step   

M, Shift M  M, Shift M  Mask Display On/Off 

 

Sratch and Sensory Error Correction: 

Windows Apple 

Ctrl + cmd +  Zoom in 

Ctrl - cmd -  Zoom out  

 

Cursor left, Shift Cursor left, Ctrl Cursor left  Move Active Correction Region left  

Cursor right, Shift Cursor right, Ctrl Cursor right  Shift Active Correction Region 

right 

Curser upwards, Shift Curser upwards, Ctrl Curser        Shift Active Correction  

upwards                      Region upwards 

Cursor downwards, Shift Cursor downwards, Ctrl         Shift Active Correction 

Cursor downwards                     Region downwards 

Image up  Image up Select Previous Correction Region 

Image down  Image down Select Next Correction Region 

C  C Activate all Correction Regions 

N  N Set New Correction Region 
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Del  Del Delete Correction Region  

+ + Enlarge Active Correction Region  

- - Minimize Active Correction Region  

 

Image Cropping: 

Cursor left, Shift Cursor left, Ctrl Cursor left  Shift Cropping Region to the left 

Cursor right, Shift Cursor right, Ctrl Cursor right   Shift Cropping Region 

to the right 

Cursor upwards, Shift Curser upwards, Ctrl Cursor upwards  Shift Cropping Region 

upwards 

Cursor downwards, Shift Cursor downwards, Ctrl Cursor Shift Cropping Region 

downwards     downwards  
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18. Integrated List of Supported Camera RAW 

Formats  

 

Located in the main menu under Information is an integrated list of 

supported camera RAW formats sorted by camera manufacturer. 

 

Selecting this menu option will open the Camera RAW Formats Win-

dow. 

 

At the top of the window you will find a drop-down selection for 

filtering the list according to camera manufacturer. This way you can 

find your camera much quicker. 
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If you would like to ensure access this list at any time by displaying it 

in an external window, use the function „Open in Browser“ to display 

the entire list in your standard internet browser or print it from 

there. 
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Hotline/Support 

Contact the FRANZIS Customer Service Team for questions about installation, problems or 
disruptions concerning this software product. 

 
E-Mail: support@franzis.de  

Telephone (Monday - Friday 12-18:00): +49 (0)180 30 02 644  
(0,09 EUR per Minute from German Landlines, mobile rates may vary) 

Telefax: 0180 300 26 45 (0,09 EUR per Minute from German Landlines, mobile rates may vary) 

 
FAQ/Webform: www.myfranzis.de  

Please bear in mind that your inquiries can only be handled by the FRANZIS Customer Service 
Support Team. This allows us to continue making lasting improvements to our quality of service 
while answering your questions quickly and professionally.  

Customer Service quick and easy: 

Have important information concerning your PC system and product ready: 

 Product Name 

 Product-ISBN-Number (These can be found on the back side of the product packaging 

located above the bar code). 

 Operating System of your PC 

 Information about your PC’s Configuration 

 

Copyright 

Franzis Verlag GmbH has taken great care in producing this product. Please acknowledge the following 

provisions: 

The following programs, routines, controls etc. located on this data storage medium or in this download are 

copyright protected by the producer or distributor as stated in the respective programs. The recipient of this 

storage medium or download reserves the right to use the programs, data or data groups not designated as 

Shareware or Public Domain for his or her own personal use appropriately and in accordance with the listed 

provisions. Programs or program elements designated as Shareware, Freeware or Public Domain may be 

used by the recipient in accordance with the rules and restrictions stated in each program or program 

element. The duplication of programs with the intent of distribution or sale of storage mediums containing the 

programs is not allowed. Franzis Verlag GmbH reserves the right for the selection, arrangement and classifi-

cation of programs and data located on this storage medium or in this download. 

The data and programs saved to this storage medium or within this download have been carefully reviewed. 

With regard to the high amount of data and programs, Franzis guarantees neither the correctness of data nor 

the error-free function of the programs. Neither the publisher nor Franzis offers any guarantee or take legal 

responsibility for the use of individual files or information, for their profitability or error-free use for any 

specific purpose.  

There is also no guarantee for the unrestricted use of all data, programs, icons, sounds or additional files 

contained in this product. Accordingly, the publishing company cannot be made responsible for the violation 

of patent or other rights of third parties. The majority of the product labeling of hardware and software as well 

as company names and logos listed in this work are also trademarks and should be viewed as such. The 

publisher has taken great care in following the notation used by the original producers.  

© 2018 Franzis Verlag GmbH, Richard-Reitzner-Allee 2, 85540 Haar bei München.  

http://www.myfranzis.de/
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Copyright 

This User Manual is protected under copyright. 

All rights to the reprinting and reproduction of this manual, in its original or trans-

lated form, are reserved. Specific portions of this work may neither be repro-

duced—whether through the process of photocopying, scanning and printing to 

microfilm, or any other—nor copied, altered or duplicated in any form for further 

purposes, including the use in teaching programs or lessons, without the compa-

ny’s express written consent. 

Disclaimer: The company takes no responsibility for damages occurring while 

using this software, whether that be in the form of personal, material or capital 

damages directly or indirectly linked to the use of the Software. The company 

additionally assumes no liability for potential technical errors or for the accuracy 

of the provided information.  

Further notices: Microsoft, MS and MS-DOS are registered trademarks and 

Windows is a label of the Microsoft Corporation in the USA and other countries. 

© 2018 Franzis Verlag GmbH, Richard-Reitzner-Allee 2, 85540 Haar bei München 

Innovations, errors and misprints included. 

 

 




